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Session: Format Documents 

 

Recap Activity  

• List the different ways in which you can to open a wWord document. 

• What is the shortcut key for searching a word in a document? 

• What are the shortcut keys to hide or show and hide formatting marks in a wWord document? 

• List the steps to save a document in an older version or format. 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

Find and Replace Text 

To find and replace a word or a phrase: 

• Click Home and then click Replace, or Click Home, then click Find followed by Replace 

• A popup window appears 

• Enter the word that you want to find in the Find What field 

• Enter the word that you want to replace it with in the Replace What field 

• If you click the Replace option, Word will replace the first instance of the matching word it finds 

•  If you click Replace All,, Word will replace all the instances of the matching word 

•  The Find Next will find the next instance of matching word 

•  To replace one word at a time, click Find Next and then click Replace 

• To see additional options for Find and Replace, click <<More >>  

 

 Shortcut keys used to Find and Replace: 

• CTRL + H will bring the Find and Replace Window on the Word screen. 

•  CTRL +F will also bring the Navigation pane where you can search for a word and replace. 

 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 
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Insert Symbols and Special Characters  

To insert symbols and special characters  

• Click Insert – Symbols – More Symbols. 

• A pop-up window appears with two tabs, Symbols and Special Characters. 

• Click the tab Special Characters to view the special characters and the keys to be used to insert them. 

• Click the Symbols tab to view the available tabs. 

• Select the symbol or character you want. 

• Click Insert. 

_______________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

Apply Text Effects 

Formatting allows you to apply different effects on the text.  

You can: 

• Change the font type and size 

• Change the text into bold or italics style 

• Underline the text 

• Apply case like lowercase, uppercase, sentence case … 

• Highlight the text 

• Change the font color 

_____ 

 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 
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To change font type and size  

• Go to Home Tab. 

• Use the options in the Font section to: 

o Change font type and size.  

  

________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

Apply Text Affects: 

To create a text box: 

• Click Insert and then Shapes 

• Select Text Box 

• An empty text box will appear 

• Enter text in the text box 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 
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Set lLine and Paragraph Spacing and Indentation 

Formatting paragraphs: 

 

 

 

 

 

 

o On the Home tab, in the Paragraph section, you will find the drop-down to make changes to line spacing.  

o A pop-up window appears.  

o You can modify the spacing before and after a line or a paragraph.  

o You can keep the text in single line spacing, 1.5 line spacing, double line spacing, or more.  

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

Apply Built-in Styles to Text 

 

• To apply a style, select the text you want to format. 

• Click the style you want in the Styles gallery. 

The different styles available are Normal, Title, Heading 1, Heading 2, Heading 3 and many more. 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 
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_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________  

 Apply fFormatting by using Format Painter 

• The Format Painter is a tool in Word that lets you copy some formatting from one object and apply it to 
another.  

  

 Steps to format and object using format painter 

• First select the object with the formatting text you want to copy. 

• Then, click the Format Painter icon.  

• Select the object to which you want to apply the formatting. to.  

• Now you can see that the object is formatted.  

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________  

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 
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_________________________________________________________________________________  

Format text in multiple columns  

•  To create text in columnar format: 

•  Click Columns dropdown icon in the Layout tab. 

•  Select the number of columns.  

•  Click More Columns to view a pop-up of Columns. 

•  In the pop-up window, you have the options to change width, spacing, Apply to and other settings. 

•  Click OK after you select the options. 

 

 

 

 

 

 

_______________________ ___________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

Insert pPage, sSection, and cColumn bBreaks  

• The typical breaks available in MS Word are: 

• Page break 

• Column break 

• Section break 

 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 
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_________________________________________________________________________________ 

 

To Insert a Page Break 

• Position your cursor where you want the break.  

• Click Insert > Break. 

• Select Page. 

 

 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

Shortcut keys to create section or page breaks: 

• ALT +P B N – to create a section break  

• Ctrl + Enter – to enter a page break 

• Ctrl + Shift + Enter – to enter a column break 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 
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Recap: 

• The Find and Replace option is useful to find multiple occurrences of a particular word or phrase 
in a document and replace it with another. 

• CTRL + H is the shortcut key to bring the Find and Replace Window on the Word screen.  

• Symbols and Sspecial characters are normal characters that don't appear on standard 
keyboards. 

• The Format Painter is a tool in Word that lets you copy some formatting from one object and 
apply it to another one.  

• The different formatting features give a good look and feel to the documents.  

• Three types of breaks can be made in a word document – page break, column break, and 
section break. 


